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1 MonitorTm Help Manual

1.1 Overview

MonitorTm is the Transfer Module program used to communicate with FAST and
DCTU units  allowing the user to

Synchronize data with the Aircraft
Synchronize data with Webserver

View Monitor Status
View Live Data

View/Change Monitor Parameters
Configure the FAST Monitor

Retrieve Log Files
Convert Log File Data  for analysis using GBSLite

Retrieve Micro-Server logs
Reset FAST box to factory

1.2 Export Classification

The MonitorTM software export classification is as per the following:
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1.3 What's New

What’s new in MonitorTM Version 4.1
- Update MonitorTM to support PC12-NGX Full flight data processing
- Update MonitorTM Graphic interface to support PC12-NGX new feature
- Update to the Graphic interface for Daher K-Factor 
- Handling of invalid value all Aircraft style
- In service issue adressed

What’s new in MonitorTM Version 4.0
- Updated MonitorTM with new features for DCTU
- Improvement to the manual data download time for Caravan.
- TBM940 new version supported (21.25).
- Fix Invalid value in Daher OEM file.
- In service issue adressed

What’s new in MonitorTM Version 3.8
- ATR42/72 exceedances detection updated.
- TBM910/930 new Garmin versions supported (20.51, 20.87 and 20.85).
- King Air B200/B300 Full flight data processing supported.
- Pilatus PC12-47E Full flight data processing supported.

What’s new in MonitorTM Version 3.7
- View/Change parameters function: current value display corrected.

What’s new in MonitorTM Version 3.6
- Q400 EMU converter 1505HI detection updated.

What’s new in MonitorTM Version 3.5
- Updated MonitorTM functions for DCTU (HTTP protocol).
- Support AW139 V6 configuration.
- Support Q200/Q300 with additional propeller Overtorque Events.
- Updated Q400 EMU converter for 1505HI event detection.
- Support FAST full flight data processing for King Air B200/B300.
- Support FAST full flight data processing for Pilatus PC12-47E.

What’s new in MonitorTM Version 3.4
- Application updated to restore 32 bit operation systems compatibility (All
functionalities except "Convert log" function)
- Updated event detection for Q200/Q300 and M600

What’s new in MonitorTM Version 3.3
- Updated Q200/Q300 exceedances, trace and snapshot capture 
- Improved Mission enhancements  and filtering Q200/Q300.
- Support enhanced mission and filtering for Daher
- Updated filtering logic for ATR42/72
- Updated AW139 Exceedance and Fault detection
- Updated filtering logic for Q400
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- Updated filtering logic for CARAVAN
- Updated trend filtering logic for F7X
- Updated trend filtering logic for F8X
- Support FAST for PIPER .
- Support Test Monitor Transmission  for EPECS
- Support Wi-Fi Configuration  EPECS
- In service issue adressed

What’s new in MonitorTM Version 3.2
- Support FAST for Daher TBM .
- Upgrade MonitorTM compatibility with new SFTP Server
- New feature to change Daher A/C serial Number
- In service issue addressed
- Support Configure Unit for EPECS

What’s new in MonitorTM Version 3.1
- Support DCTU for EPECS.
- Support FAST for ATR42/72 FDAU V3.
- New feature to manually check for Monitor TM version upgrade
- Application upgrade for 64 bit support and Tablet Windows 8 Pro.

What’s new in MonitorTM Version 3.0
- Support FAST for ATR PBMS and RSN.
- Support FAST for ATR42/72 FDAU V2b.
- Support FAST for King Air B200/B300.

What’s new in MonitorTM Version 2.9
- Support FAST for ATR Propeller Balance.
- Support FAST for King Air B200/B300 and generic ETM conversion
- Support MicroFAST Full Flight Data Conversion 
- Support Q400 and ATR42/72 OOOI events
- PW150A EMU converter updated : missing traces extracted

What’s new in MonitorTM Version 2.8
- Latitude conversion issues addressed
- Windows 10 compatibility 

What’s new in MonitorTM Version 2.7
- Support FAST for Dassault Falcon 8X conversion.
- Support FAST for Cessna Latitude 680A Phase 2 (enhanced cruise monitoring)
- Support FAST for AW139 Phase 2 (APAC)
- Support FAST for Q400 propeller vibration monitoring 
- Support enhanced filtering of Q400 trend events
- Wi-Fi Configuration  for data offload 
- Improved View Live Data  performance
- Improved communication for FAST Monitor communication.
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What’s new in MonitorTM Version 2.6
- In service issues addressed.

What’s new in MonitorTM Version 2.5
- Support FAST for Cessna Latitude 680A EDU conversion.
- Support enhanced filtering of Caravan trend events
- Support new FOQA cleaning process
- Improved GUI performance, especially for Windows 8.1.

What’s new in MonitorTM Version 2.4
- ATR42/72 conversion update for ARINC label decoding

What’s new in MonitorTM Version 2.3
- Support FAST for AW139
- Support FAST for Q400 Phase 2 (1505HI, MTOP Monitoring, etc.)
- Enhanced Retrieve Log Files Function .

What’s new in MonitorTM Version 2.2
- Support FAST for ATR42/72 aircraft.
- New "Delete Non-Transmitted Logs" password protected function.

What’s new in MonitorTM Version 2.1
- Enhancements to Q400 data conversion.
- Improved communication for configuring the FAST Monitor.
- Full flight data conversion options simplified.

What’s new in MonitorTM Version 2.0
- New drivers to support Windows 8.
- New “FAST Factory Reset”  function.
- New “Get Micro Server Logs”  function.
- Improved Sync to Aircraft.
- Improved data conversion.

What’s new in MonitorTm Version 1.8
- Support for Cessna Caravan aircraft: 
New “Retrieve Log Files” interface, New ‘’View/change Monitor Parameter” interface
to display Engine/Flight cycles and creep information.
- Improved test monitor transmission function.

What's new in MonitorTm Version 1.7
- Data conversion function for Q300 application timestamp fixed.

What's new in MonitorTm Version 1.6
- Data conversion function for Q300 application
- Preference  "Tag Data Transmitted" is not ON by default.
- Successful data conversion of files with multiple legs (error codes 17 and 18)
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What's new in MonitorTm Version 1.5
- Data conversion function for Q400 EMU and QAR files
- Support of new FAST embedded software v1.1.0
- Improve Convert Log function user interface for more flexibility

What's new in MonitorTm Version 1.3
- Data conversion function improved for LJ60 application
- Data conversion performace improved

What's new in MonitorTm Version 1.1
- Windows 7 32-bit and 64-bit support
- Updated communications to monitor
- Updated user messages
- Removed transparent function
- Added View/Change Monitor Parameters  function
- Updated F7X event list
- Updated synchronization procedure to synchronize to Webserver

What's new in MonitorTm Version 1.0
First release of the program including the following functions:
- Synchronize data with the Aircraft
- Synchronize data with WebECTM
- View Monitor Status
- View Live Data
- Configure the FAST Monitor
- Retrieve Log Files
- Convert Log File Data  foranalysis using GBSLite
- Support for F7X aircraft
- Support for LJ60 aircraft

1.4 Hardware Requirements

Communicating with Monitor Functions
- For FAST Monitor, connection via GSE USB cable on J3 connector
- For DCTU Monitor, connection via GSE USB cable on J2 connector (USB mini-B)

FAST Monitor Radio frequency radiation exposure Information:

“This device complies with part 15 of the FCC Rules. Operation is subject to the following two

conditions: (1) This device may not cause harmful interference, and (2) this device must accept any

interference received, including interference that may cause undesired operation”.

“Changes or modifications not expressly approved by the Pratt & Whitney Engine Services could

void the user's authority to operate the equipment”

“The integrated radio modules [IC: 7830A-PLS62W & IC: 5969A-TIWI101] on this device  has been

approved by Innovation, Science and Economic Development Canada to operate with the antenna

types listed below, with the maximum permissible gain indicated. Antenna types not included in this
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list that have a gain greater than the maximum gain indicated for any type listed are strictly

prohibited for use with this device.” 

WiFi antenna: Single element, 50 ohms, vertical/omnidirectional, RPSMA,  Dipole, Freq Rng: 2.4-

2.5GHz, 1.5dB gain @ 2.4GHz or equal.

Cellular antenna: Single element, 50 ohms, Linear, omnidirectional, SMA, VSWR:2.1, 

Frequency range/Gain: 698-960MHz 1.5dB, 1710-2170MHz 3.0dB,  2500-2700 4.5dB  or equal.

To comply with FCC  rule parts 2.1091 /  ISED RSS 102  RF exposure requirements for mobile

transmitting devices, this device and  the antenna(s) used for this transmitter must be installed to

provide a separation distance of at least 30 cm ( ~ 12 inches) from all persons (and must not be co-

located or operating in conjunction with any other antenna or transmitter.

1.5 Software Requirements

All Installations:
- Windows 7, Windows 8, Windows 8.1, Windows 8.1 Pro or Windows 10
- Windows 64bit operation systems (All functionalities)
- Microsoft Internet Explorer 6.0 or above
- PDF Reader

Tablet Installations:
-  Windows 8 Pro 64bits

Communicating with Webserver
- Internet Access

Optional:
-GBSLite Diagnostic Module for data analysis on PC

1.6 Program Installation

Initial Installation
To install MonitorTm for the first time, launch the set-up program and follow
instructions.

The default location for installation is C:\GBS-PWC however; when GBSLite is
already installed on the PC, the default installation location will automatically be
configured to the GBSLite installation directory.  If GBSLite is to be installed after
MonitorTm is installed, it should be installed in the same location as MonitorTm

Automatic Updates
When the program starts, it verifies if there is a new version available.  If an update
exists, the program will indicate that an update is available and to perform Monitor
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TM Auto-Update  in the Help Menu .

Whenever MonitorTM synchronizes with the Web and an update is available, the
user will be prompted to download the new version.  If the user selects to download
the new version, it will be installed at next program startup with user required to
follow on screen instructions

A shortcut will be installed on the desktop

68
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1.7 Program Version

Accessing:

Program version information displayed

1.8 Printing a hard copy of manual

Accessing:

Upon selection, the PDF Help Manual will be displayed

Adobe Acrobat is required.  See Software Requirements  for details11
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2 Accessing MonitorTm Functions

2.1 Starting and Closing the Program

To start the MonitorTm program, double click on the MonitorTm desktop icon

To close the MonitorTm program use or

2.2 Main Program View

Functions in the MonitorTm Main Program View can be accessed in two
different ways

The Side Bar: Large buttons with the most commonly used functions
Sync to Webserver , Sync To Aircraft , Monitor Status , Live Data ,
Test Monitor Transmission .

58 20 25 34
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The Menu Bars: contain side bar functions as well as other functions

The File Menu has the following functions available:
Print ,Print Preview , Print Setup , Exit

The View Menu has the following functions available:
Session Log , Saved Monitor Status , Preferences , View Data in
GBSLite

71 71 71 15
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The Monitor Menu has the following functions available:
Sync to Webserver , Sync to Aircraft , Monitor Status , Live Data ,
View/Change Parameters , Configure Unit , Retrieve Log Files

The Expert Menu has the following functions available:
Communication Settings , Expert Command Mode , Convert Log ,
Test Monitor Transmission , Get Micro Server Logs ,FAST Factory
Reset

The Help Menu has the following functions available:
About Monitor , Monitor TM Auto-Update  , Help Manual

58 20 25 34
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Functions are always performed in the main area

Communication settings and status messages are always displayed in the
lower area

When connected to the monitor, a photo of the monitor is displayed
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3 Communicating with the Monitor

3.1 Sync to Aircraft Function

Accessing:

The Sync to Aircraft function is used to download log files from the monitor to the pc
and to upload configuration files from the pc to the monitor

This function automatically performs the following 2 functions
1. Retrieve Log Files Function
2. Configure Unit Function

Refer to individual function descriptions for further details

3.2 Retrieve Log Files Function

Accessing:

This function retrieves log files from the monitor for the purpose of analyzing the data
locally on the computer or to transfer data to the P&WC Web server.

The files to be retrieved can be selected by the user and download time is indicated.
 The column header check box  can be used to select all log files.

When the estimated retrieval time is less than a configurable limit, all files will be
retrieved without requiring user selection.  Refer to Changing MonitorTm
Preferences  for details

20
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By default, retrieving logs from the monitor does not modify their transmitted status in
the monitor (i.e. the monitor will still upload them to the web via GSM cellular).  Refer
to Changing MonitorTm Preferences  for details

For the Caravan application and all FAST serial number 45xxxx, the user can either
retrieve transmitted or not transmitted log files for ETM and Full Flight data files. See
the screenshot below:

For other applications, the user can either retrieve transmitted or non transmitted log
files.

70
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After selection, the user can check boxes of desired files to be retrieved and click
the start button to start the process. A retrieve progress status will be shown.
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For FAST system containing Micro Server Software version 2.9 or higher (refer to
PW_VER field in the Monitor Status Function ), the download time is reduced
when all log files are selected for download.

To retrieve all log files, select the checkbox on the top left in the Log File Selection
screen. The download process will be displayed in seconds.

Note: MonitorTM download all files packaged in a TAR format using Open Source
Software Windows TAR library where distribution is managed by license terms as
per link http://creativecommons.org/licenses/by-sa/3.0/legalcode

3.3 Configure Unit Function

Accessing:

This function is used to reconfigure the monitor settings when they need to be
modified

This function uploads configuration files from the computer to the monitor

25
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Configuration file versions in the monitor are compared with configuration file
versions on the computer

When the configuration file versions on the computer are more recent than those in
the monitor, the program will proceed with the configuration of the monitor

When the configuration file versions on the computer are the same or older than
those in the monitor, the user must choose to proceed with the configuration of the
monitor.

After the files are uploaded into the monitor, the monitor will reboot.  This should take
approximately 1 minute.
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3.4 Monitor Status Function

Accessing:

This function provides an overview of the status of the monitor and the status is
updated continuously as long as the function is selected. 

The status can be saved to an xml file or printed via File>Menu/Print.

The saved status can be viewed via the View Saved Monitor Status Function

The following are the possible status messages that can be seen as well as
recommended actions to take 

For the FAST Box :

Displayed Name Description
Serial Number FAST Box serial number

Time FAST Box time of day

Source of Time Source that FAST syncs to for time of day clock

LOCAL : Time is synchronized to the FAST box

REMOTE : Time is synchronized to the EEC (Electronic Engine Controller)

Note: This option is not available on all applications
MS : Time is synchronized to the ground server

CP Software The CP (Control Processor) software version

73



The export control classification with respect to this document is ECL: NSR, P-ECCN: 9E991.

26 MonitorTm Help Manual

© 2019 Pratt & Whitney Canada Inc

Version

CP CRC The CP (Control Processor) software CRC (Cyclic Redundancy Check)

Install ID Installation ID field of the FAST Box from the loaded configuration

Configuration
Version

The loaded configuration version

Number of Box
Power On

The total cumulative number of times the box has been powered on

Number of Box
Power On In
Seconds

The total cumulative number of seconds the box has been powered on

PW_VER Micro server software version

Aircraft Tail
Number

The aircraft tail number field stored in the configuration

Aircraft
Operator

The aircraft operator field stored in the configuration

Aircraft Owner The aircraft owner field stored in the configuration

# of Logs in
Memory

The total number of logs in memory that are pending upload to the Micro-
Server Compact Flash

% of Log Memory
Used

The percentage of log memory used

UNTXD_FILES Number of non transmitted files
Box System
Condition

The box system condition

If fault or caution status, please perform the Expert Commands function  :
Recent Faults to obtain a list of the last 10 faults and call P&WC Customer
First Center.

If the problem persists, download system logs using Retrieve Log Files
function

Communication
Between MS and
CP

Indicates if communication between the Micro-Server processor and Control
processor is running

 : Communication between Micro-Server Processor and Control

Processor is running
 : not necessarily a problem and can occur during a box power up

- Try closing the function, wait 2 minutes; and then retry the Monitor Status
function
- If NO still displayed, call P&WC Customer First Center

For the DCTU :

Displayed Name Description

Serial Number DCTU Box serial number

MFG Date Date the DCTU was manufactured
in the following format:
MM/DD/YYYY

MFG Revision Description of the revision
of the hardware

47
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Displayed Name Description

Last Repair Date the DCTU was last repaired in the following format: MM/DD/YYYY

PW Version Version of the software package that was installed in the DCTU.

MFAST-W-368-1 Version Version of the EPECS interface software that must be controlled and not
updated over the air.

MFAST-W-368-1 MD5 32 character md5 sum of the EPECS interface software that must be
controlled and not updated over the air.

Date Time Date/Time when the
monitor_status command was issued. Current date/time in the following
format: MM/DD/YY HH:MM:SS tt UTC

where tt = AM or PM
Config Version Version of the configuration file that is currently loaded for the RTD recording

process.
Config Status Status of the configuration file that is currently loaded. See Configuration

GSE section for expected status format.

XML Version Version of the xml file that is currently loaded.

XML Status Status of the xml file that is currently loaded. See Configuration GSE section
for expected status format.

Install ID User string to identify the specific installation of the box. From the XML
configuration file.

Power On Count Total number of times the system has been powered on.

Current Power On Time (s) Time in seconds for the current power on.

Total Power On Time(s) Total time in seconds that the box has been powered across power
cycles.

Untransmitted Files Total number of files that are waiting to be offloaded from the DCTU.

Memory Used Total percentage of log memory that is used.<###>% [0..100]

Tail Number The aircraft tail number from the XML configuration file.

Operator The aircraft operator from the XML configuration file.

Owner The aircraft owner from the XML configuration file.

Aircraft Style The aircraft style from the XML configuration file.

Recording Status Current status of the RTD Recording process.
 IDLE means no channels are being recorded.
 RECORDING means one or more channels of data are being recorded.

RF Power RF Power is Enabled or Disabled

GSM Status Current status of the cellular connection.
Example:
"RF Disabled"
"Connected (-77dB,'310410',INT/EXT)"
"No SIM card (INT/EXT)"
"SIM PIN Required (INT/EXT)"
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Displayed Name Description

WIFI Status Current status of the DCTU internal Access Point (AP) connection
Example:
"Not Registered (-77dB,INT/EXT)"
"Registering (INT/EXT)"
"Waiting for IP Conn (-77dB,INT/EXT)"
"Unknown"

WIFI AP Status Current status of the MicroFAST connection ("Station Mode") to a local
Access Point (AP). 
Example:
 "Not Connected"
"(-59dB) WiFi Linksys 192.168.1.198"

VPN Status Current status of the VPN connection.
Example : 
"Not Connected"
"Connected [GSM-Home]" "Connected [WIFI-Wifi Linksys]" "Connected
[UNKNOWN-]"

PMIC Version This is the Software Identification field returned by the PMIC in its Status
Response message.

Incognito Mode Incognito mode  status:
Example:
"Enabled"
"Disabled"

EEC Maintenance Mode EEC Maintenance mode status

3.5 Test Monitor Transmission Function for FAST

Accessing:

This function verifies that the monitor can transmit data to the Web server
successfully
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The following are the possible test status messages that can be seen as well as
recommended actions to take

Possible
Values

Description Recommended Action

System
Condition

blank System Condition verification
is not yet complete

PASS System Condition is OK

FAIL System Condition is FAULT
and cannot transmit through
GSM

Please perform the Expert Commands
function  : Recent Faults to obtain
a list of the last 10 faults and call
P&WC Customer First Center

Weight On
Wheels
Condition

blank Weight on Wheels verification
is not yet complete

PASS WOW discrete input is TRUE

FAIL WOW discrete input is
FALSE and GSM cannot be
enabled

Verify the resistance between J1
(harness connector) pin 15 and pin 2
or 3. At least one of them should be <
100 ohm.

On Ground
Trigger

blank On ground criteria verification
is not yet complete

PASS On ground criteria is being
met

FAIL On ground criteria is not being
met and GSM cannot be
enabled

1. Ensure engines are off and wait 2
minutes
2. Repeat Test Monitor transmission. 
If FAIL remains, perform Live Data
Function  to verify validity of
parameters. If any parameters are
invalid, correct the problem.
3. Repeat Test Monitor transmission. 
If FAIL remains, perform Expert
Command function  : show config
and save/send to P&WC Customer
First Center for review of show config
and live data parameter values from

47

34

47



The export control classification with respect to this document is ECL: NSR, P-ECCN: 9E991.

30 MonitorTm Help Manual

© 2019 Pratt & Whitney Canada Inc

step 2

Record Data
Trigger

blank Configurable data record
triggers verification is not yet
complete

PASS Configurable data record
triggers are inactive. FAST is
not recording data

FAIL Configurable data record
triggers are active. FAST
cannot upload log data while
recording

1. Ensure engines are off and wait 2
minutes
2. Repeat Test Monitor transmission.
If FAIL remains, perform Live Data
Function  to verify validity of
parameters. If any parameters are
invalid, correct the problem.
3. Repeat Test Monitor Transmission.
If FAIL remains, perform Expert
Command function : show config
and save/send to P&WC Customer
First Center for review of show config
and live data parameter values from
step 2

Micro Server
Ready

blank Micro-Server interface
verification is not yet
complete

InProgress
##%

FAST waiting for Micro-Server
interface to become ready. 
This can be displayed for up
to 2 minutes

PASS Micro-Server interface is
ready for use

FAIL Micro-Server interface is not
ready for use

Repeat test one more time.  If the test
fails again, perform Expert Command
function  : Micro-Server Status and
contact P&WC for support

GSM Sim Card blank GSM SIM card verification is
not yet complete

InProgress
##%

FAST waiting to detect and
read the SIM card.  This can
be displayed for up to 3
minutes

PASS SIM card is detected and card
ID detected

34
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FAIL FAST not able to read the
SIM card ID

1. Verify that the SIM card is installed
properly, cycle box power
2. Repeat Test Monitor Transmission
function.  If FAIL remains, remove and
re-insert the SIM card, cycle box
power.
3. Repeat Test Monitor Transmission
function.  If FAIL remains, remove SIM
card and test in a cellular phone of the
same network provider (i.e. AT&T,
Rogers, or unlocked, ...)
4. Repeat Test Monitor Transmission
function.  If FAIL remains, contact
P&WC Customer First Center for
further support

GSM Signal blank GSM signal strength
verification is not yet
complete

InProgress
##%

FAST waiting to connect to a
GSM network.  This can be
displayed for up to 5 minutes

PASS -
###dB

FAST can connect to GSM
network.  Signal Strength
displayed (dB)

Preferred to see -95db or greater (i.e. -
60 is good). Try relocating aircraft if
signal strength is poor (i.e. out of
hangar, or different airport) and repeat
Test Monitor Transmission function.

FAIL FAST was unable to connect
to a GSM network within the
expected time

1. Verify the account is active with
network provider (i.e. AT&T, Rogers,
etc..)
2. Repeat Test Monitor Transmission
function.  If FAIL remains verify you
are in cellular range by removing SIM
card and testing in a cellular phone of
the same network provider. (need to
cycle box power after reinserting in
FAST box)
3. When in cellular range, repeat Test
Monitor Transmission function, verify
antenna is connected to FAST box
(GSM connector)
4. When antenna is connected, repeat
Test Monitor Transmission function.  If
FAIL remains, contact P&WC
Customer First Center for further
support

VPN
Connection

blank VPN Connection verification is
not yet complete

InProgress
##%

FAST waiting to establish
VPN connection to ground
server.  This can be displayed
for up to 5 minutes

PASS FAST established VPN
connection to the ground
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server

FAIL FAST unable to establish
VPN connection to ground
server within expected time

1. Verify that a data plan is activated
with the cellular network provider.  If
no data plan, activate data plan and
repeat Test Monitor Transmission
function.
2. If FAIL remains, verify GSM using
GSM Signal Strength indication above
(i.e. PASS -###dB).  If GSM Signal
Strength is too low, try to correct the
problem and repeat Test Monitor
Transmission function.
3. If FAIL remains, contact P&WC
Customer First Center for further
support

Upload Status blank Upload Status verification is
not yet complete

MoveLogsTo
MS

FAST is moving log data from
control processor to Micro-
Server

If this message is seen for more than
5 minutes:
1. Perform Expert Command function

 : Verbosity Normal to see
messages
2. If messages beginning with
"Upload" seen, wait for completion. 
Perform Expert Command function
: Verbosity Off and repeat Test
Monitor Transmission function.
3. If this status is seen for more than
5 minutes again, or if no messages
beginning with "Upload" seen, contact
P&WC Customer First Center for
support

MoveLogsTo
Ground ##
%

FAST is moving logs from
Micro-Server to Ground via
GSM

If number is incrementing, wait for
completion
If number is not incrementing after a
few minutes, contact P&WC
Customer First Center for support

PASS FAST has moved all log files
to ground server and verified

This Is The Final Overall Status of the Test Monitor Transmission function

Stopped There has been no test
activity since the last power-
on

Cycle box power and repeat Test
Monitor Transmission Function

InProgress running each step to verify log
transmission to ground server

PASS Test completed and
successfully transmitted data
to the ground

Fail:
<FailReaso
n>

Test stopped because one of
the above statuses has failed
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3.6 Test Monitor Transmission Function for DCTU

Accessing:

This function verifies that the monitor can transmit data to the Web server
successfully by using one of the two options

Function using Cellular
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Function using WI-FI

3.7 Live Data Function

Accessing:
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The Live Data function allows the user to view and record live data from the monitor's
available data sensors.

The user must select the sensors to display using check boxes.  The column header
check box  can be used to select all sensors.

Click Retrieve Selected to proceed

The values and units of selected sensors are displayed.

Any invalid sensors are displayed in red.

Start and Stop Recording buttons permit recording a sequence of live data.

Refer to the Analyzing Data section for analysis 



The export control classification with respect to this document is ECL: NSR, P-ECCN: 9E991.

36 MonitorTm Help Manual

© 2019 Pratt & Whitney Canada Inc

3.8 Communication Settings Function

3.8.1 Accessing

The Communication Settings Function can be used for detecting and
troubleshooting connection settings and contains two options.  For troubleshooting
guidelines, refer to Communication Troubleshooting

3.8.2 Auto-Detection

Automatically detects the Connection Type connected to the monitor by screening
the available COM ports. Performed automatically prior to each function requiring
communication with the Monitor.

74
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3.8.3 Manual detection

Find the com port via Device Manager

Disconnect FAST USB cable and  Expand the Ports menu .
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Connect the FAST USB cable,  the Ports will automatically update

Note: If the RS-485 Port (COMX) is not displayed, USB driver is not properly installed, please refer
to FAST USB GSE Cable Driver Installation .

Open Monitor TM 

Under Expert , select Communication Settings
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From Connection Type scrolling menu select the com port found previously (i.e :

COM6)

Click on

Communication settings are displayed in the Monitor Type, COM Port and Baud
Rate fields.

Communication status is displayed in the Message field

For DCTU from the Monitor Type scrolling menu select "DCTU"

From Connection Type scrolling menu select the "Ethernet/RNDIS" 
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Communication status is displayed in the "Message"  field.

3.9 View/Change Monitor Parameters

Accessing:

The View/Change Parameters function can be used to change parameters in your
monitor.

3.9.1 View/Change Monitor Parameters for ATR42/ATR72 application

For ATR42/72 and AW139 applications, the function enables the user to view/
change the fast box time and enter the engine serial number information.  For
ATR42/72 only, the user can also clear the engine serial number the engine serial
number is available via the ARINC 429 data.

View/change FAST box time and engine serial number information
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After you enter the new values, select the write button.

The new parameters values will be updated in the monitor and the Current Value
column will be refreshed. Verify the current values are appropriately refreshed before
closing.
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Click "Proceed" to clear the engine serial numbers stored in the FAST box. 

3.9.2 View/Change Monitor Parameters for CARAVAN application

For Caravan application, the function enables the user to view/change the fast box
time, engine serial number, flight/engine cycles and creep information.  The user can
also reset creep faults and CAS Previous Exceed messages.

View/change FAST box time, engine serial number, flight/engine cycles and
creep information

After you enter the new values, select the write button.

The new parameters values will be updated in the monitor and the Current Value
column will be refreshed. Verify the current values are appropriately refreshed before
closing.
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View/Reset creep faults:

Click “View Creep Fault” to display current creep faults:

A list of active creep faults is displayed, including creep fault type and date and time
of occurence. To reset creep faults, click “Reset Creep Fault”.

Creep faults will be cleared in the monitor and creep fault list refreshed.
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Click “Reset Prev Exceed” to reset Exceed messages from the crew-alerting system
(CAS).

3.9.3 View/Change Monitor Parameters for other FAST applications

For other applications, the function enables the user to view the configuration
Version and when applicable clear and enter the engine serial number information. 

After you have entered the new value, select the "Write: button.

The new value will be written to the monitor and the Current Value column will be
updated.

To clear the Engine serial number stored in the FAST Box click "Proceed"
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3.9.4 View/Change Monitor Parameters for DCTU application

For DCTU applications, the function enables the user to view/change the engine
serial number information, the power section serial number,Engine Usage , the Low
cycle Fatigue, Creep, Aircraft information, Engine Data plate and LRU's. 

View/change parameters for DCTU main page
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After you enter the new values, select the write button.

The new parameters values will be updated in the monitor and the Current Value
column will be refreshed. Verify the current values are appropriately refreshed before
closing.
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Click "Proceed" to clear the engine serial numbers stored in the FAST box. 

3.10 Expert Command Mode Function

Accessing:

The Expert Command Mode function can be used to communicate with the monitor
by sending commands and displaying monitor responses

The user can select commonly used expert commands from a menu

When the Send button is selected
- The monitor responses are displayed 
- The session can be saved and printed
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Selecting the Advanced button requires entering a password for advanced
troubleshooting and permits typing any command. To obtain the password, contact
P&WC Customer First center.

The program then permits writing to the actual command prior to clicking the Send
button
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3.11 Get Micro Server Logs

The Get Micro Server Logs function is used for advanced troubleshooting when
instructed by P&WC personnel.

The function will automatically download all micro server logs to the users local
computer.

The options are displayed as follow :

Once the option selected the log retrieval process starts

To transfer the data to PWC for analysis, the user must perform the Sync To
Webserver  function.

3.12 FAST Factory Reset

The FAST Factory Reset function is to be used for advanced troubleshooting when
instructed to do so by P&WC personnel.

The FAST Factory Reset will delete all non-transmitted data from your FAST box

58
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and configure it to the latest configuration. Once this function is started, it cannot
be cancelled.

Selecting the FAST Factory Reset button requires entering a password. To obtain
the password, contact P&WC Customer First center.

After the password is entered, the program will determine if the configuration files for
the FAST box are located on the local computer. If the files are not available, please
perform the Sync To Webserver function.

After the password is entered and the configuration files are available on the local
laptop, the program will begin the reset function. During the reset it is not possible to
navigate, or from the Factory Reset Screen.

At the end of the function, the program will reconfigure the box with the configuration
files located on the local computer.
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3.13 Delete Non-Transmitted Logs

The Delete Non-Transmitted Logs function may be used when instructed to do so by
P&WC personnel. The function is used to erase all non-transmitted data in the FAST
box. Once this function is started, it cannot be cancelled.

Selecting the Delete Non-Transmitted function requires entering a password. To
obtain the password, contact P&WC Customer First center.

After the password is entered, the program will begin the erase function. During the
erase function it is not possible to navigate from the Delete Non-Transmitted Logs
screen.

3.14 Wi-Fi Configuration

The FAST monitor revision E or higher is capable to offload data via Wi-Fi
connection. The compatibility can be verified by using the Monitor Status  function
to confirm that the MSSIM version (PW_VER) is 3.0 or higher.

For FAST to automatically connect to a Wi-Fi network, it must first be configured
using MonitorTM and a pc connected via the GSE cable.

Accessing:

25



The export control classification with respect to this document is ECL: NSR, P-ECCN: 9E991.

52 MonitorTm Help Manual

© 2019 Pratt & Whitney Canada Inc

If the FAST is not compatible with Wi-Fi, the user will see the following error
message.

Once connected the user will see a screen similar to the one below. 

Already configured Wi-Fi networks are displayed with signal strength, if in range. If
the FAST is already connected to a network, "Connected" will be displayed next to
the appropriate configured network SSID. The user can remove (Forget) individual
or all configured networks. 

The passwords for already configured network SSIDs are not stored on the local
computer. The user may enter a new password. Only when entering a password, the
user can select the icon to view what is being entered. Only the FAST stores the
network passwords.  It is recommended that Forget All networks is done prior to
FAST removal. If the FAST is returned to P&WC, the network passwords could be
accessed by P&WC personnel.

Available networks are displayed with signal strength. Only available Wi-Fi networks
that do not contain special characters or spaces will be available to connect.The
user can enter a password for any available networks.

The user can manually enter a Network SSID, security and password. The user can
enter one network at a time. SSID cannot contain special characters or spaces. Only
networks with no security, WPA or WPA2 security are compatible.
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In all cases when the Edit button is selected, the user may cancel.

3.15 WI-FI Configuration for DCTU

For DCTU to automatically connect to a Wi-Fi network, it must first be configured
using MonitorTM and a pc connected via the USB (RNDIS/Ethernet Gadget) cable.

Accessing:

Once connected the user will see a screen similar to the one below. 

Already configured Wi-Fi networks are displayed with signal strength, if in range. If
the DCTU is already connected to a network, "Connected" will be displayed next to
the appropriate configured network SSID. The user can remove (Forget) individual
or all configured networks. 

The passwords for already configured network SSIDs are not stored on the local
computer. The user may enter a new password. Only when entering a password, the
user can select the icon to view what is being entered. Only the FAST stores the
network passwords.  It is recommended that Forget All networks is done prior to
FAST removal. If the FAST is returned to P&WC, the network passwords could be
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accessed by P&WC personnel.

Available networks are displayed with signal strength. Only available Wi-Fi networks
that do not contain special characters or spaces will be available to connect.The
user can enter a password for any available networks.

The user can manually enter a Network SSID, security and password. The user can
enter one network at a time. SSID cannot contain special characters or spaces. Only
networks with no security, WPA or WPA2 security are compatible.

In all cases when the Edit button is selected, the user may cancel.

3.16 DCTU Icognito mode

Accessing :

The Incognito Mode is to be used as an advance feature to disable the Cellular and
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the Wifi connection up to a period of 14 days.

In Days, Hours, Minutes you have the capability to enter the period of time desired to
disable DCTU connectivity, the overall period should be less than 14 days.

In Comment section the user can add additional information about the disabling

When Incognito Mode is active, the screen shows all the information about when the
function was activated, when it will end and any additional comments .
You can either re-enable the DCTU by clicking on the 'Re-enable' button or extend
the time of the Incognito Mode by clicking on 'Extend Time' .The Incognito Mode can
be exit at anytime by clicking on the 'Close' button. 
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After re-enabling or extending the time you can click on 'Close' to exit the menu.
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4 Communicating with Webserver

4.1 Sync to Webserver Function

Accessing:

This function synchronizes the computer with the P&WC Webserver
- uploads log files to Webserver
- downloads configuration files to the pc
- downloads updates of the MonitorTm program

The user must manually enter the related monitor serial numbers.

The program will then transfer 
- configuration files from the Webserver to the computer
- log files from the computer to the Webserver 
- MonitorTm program updates from the Webserver to the computer if available
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